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ABSTRACT 

 

Double bass is a string type instrument that has been evolved each generation due to 

the increased demand for better quality sound. A lot of amplifiers and transducers 

were used to transferring and amplifying the original sound of the contra bass but the 

most important is to maintain its original acoustic timbre of wood-bass 

characteristics. The main objective of this project is to determine stress concentration 

area on the bridge of contra bass in the proportion to propose the best mounting 

position of the sound transducer. Based on author’s research and background study in 

FYP I, the acoustic timbre characteristic would be improved by embedded the sensor 

at the location on the bridge with maximum stress concentration. To determine the 

location, the author has chosen Finite Element Analysis using ANSYS among some 

available methods due to its high feasibility. CATIA: Sketch Tracer also being used 

in conjunction with ANSYS in the development of the bridge solid modeling. Stress 

concentration area on the bridge was successfully determined at the end of the 

project and all related analysis, results and discussion had been compiled in the 

thesis.  
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CHAPTER 1 

INTRODUCTION 

 

1.1 Background Study 

The revolution of musical instrument has been started thousand years back as old as 

the history of man civilization (Neville, 2000). Music can be considered as one way 

communication to express feelings and to convey messages. As time goes by, the 

demand on the music field also been increasing parallel with the transformation of 

new era. In this project, it focussed on the need of sound amplification of contra bass. 

There are increasing in number of spectators and fans which introduced function of 

sound amplification. Many types of amplifier such as microphone, magnetic 

transducer and many more were made. Apart from that, there also some come up 

with new instrument with built-in amplifier. This new modern type of instrument 

may be richer in sound quality and superior in responsiveness, but if it does not 

really maintain the original sound then it is considered not a better instrument 

(Neville, 2000). In the production of acoustic timbre of wood contra-bass 

characteristics, the good understanding on the mechanism, acoustic characteristics 

and deep view from physics side of music instrument would provide details of sound 

production of an instrument.  

 

Among the available method in engineering field nowadays, the author has chosen 

Finite Element Analysis in order to determine the best mounting position of the 

sound transducer on contra bass’s bridge. The positioning of sound transducer on the 

highest stress concentration area may be able to produce superior sound which still 

maintains the timbre characteristics of contra bass. Proper procedures should be 

followed in order to achieve the objectives.   
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1.2 Problem Statement 

The need of amplification has been very important in music industrial nowadays. A 

lot of amplifiers, pickups and transducers were come into the role of transferring and 

amplifying the original sound of the contra bass. The important part to be deal with is 

to maintain the acoustic timbre of wood-bass characteristics. Miller & McIntire, 1987 

say that “Acoustic emission is the class of phenomena where transient elastic waves 

are generated by the rapid release of energy from localized sources within a material, 

or the transient waves so generated” (Miller, 1987).  

 

Bridge is the part of these instruments which will be further explained in Chapter 2. 

The significant of the project is to maintain the timbre characteristics of the sound 

produced by contra bass and propose the best mounting position of sound transducer 

which are cost effective and having high efficiency of amplification.   

 

Nowadays, there were many sound transducers introduced. They are producing 

superior sound than contra bass without sound transducer. The problem arises when 

improper positioning of the sound transducer may cause sound instability as for 

example, the used of microphone may include external sound which are not 

originated from contra bass. It called external disturbance. Apart from that, improper 

positioning may cause discomfort to the player when playing the contra bass. As for 

example, some sound transducer is located at the body of the contra bass as the 

wiring will cause inconvenient playing mode to the player.  

 

The significant of the project is to find the area with the highest stress concentration 

which the author believes will be the perfect location to embed the sound transducer 

and able to reproduce the acoustic timbre of wood-bass sound characteristic. The 

project is cost effective as it only deals with the analysis and simulation of stress 

distribution on the bridge. Old century bass player will not have to buy new design of 

contra bass as they only have to own a bridge embedded with sound transducer 

which located at the highest stress concentration area. 
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1.3 Objectives and Scope of Study 

There are several objectives that need to be achieved at the end of the project which 

are: 

 To perform Finite Element Analysis in the market to analyse complex shape 

of the bridge. 

 To determine the best mounting position of sound transducer. 

In order to analyse the 3D solid modelling in ANSYS, first the author need to 

translate the complex shape of the bridge into digital model. The scope of the project 

is to determine the area with the highest stress concentration on the bridge. Upon the 

determination of the stress location, software such as CATIA and ANSYS will be 

applied.  

The project is relevance to be done as music is a part of life. The music lovers are 

everywhere and this proves that the project would have a positive feedback from 

them. The project applied the knowledge in using CATIA and ANSYS. Basic 

knowledge in design is needed. Apart from that, main method used to determine the 

best mounting position of sound transducer is using Finite Element Analysis which is 

the most popular used method in engineering field which it provides various types of 

analysis such as Von Misses Stress Analysis, Thermal Analysis and many more.  

The author has been given at about eight (8) months for the project accomplishment. 

It is believed that the author will manage to finalize the project within given timeline 

as the author will be only focussing on the analysis and simulation part of the project 

which is determining the best mounting position of sound transducer using Finite 

Element Analysis.  
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CHAPTER 2 

LITERATURE REVIEW 

 

In order to understand and to achieve the desired objectives of the project, thorough 

reading regarding contra bass and also factors that manipulate the characteristics of 

sound production should be done. Hence, comprehensive and depth research for 

resources are needed for the accomplishment of the project. Literature review is 

prepared to provide the author better understanding on essential parts of the project. 

2.1 Contra Bass 

 

Figure 1: Size difference of Viols Family Instruments 

Contra Bass also known as upright bass, string bass, double bass and many more is 

regarded as the largest instrument in viols family instrument as can be referred as 

Figure 1. It has four strings and each tuned at E1 (41.2 Hz), A1 (55.0 Hz), D2 (73.4 

Hz) and G2 (98.0 Hz). While the cello, which also have four strings but each tuned at 

C2 (65.4 Hz), G2 (98.0 Hz), D3 (147.0 Hz) and A3 (220.0 Hz). Cello is the second 

largest instrument in string family which is about twice of a violin (Neville, 2000) 

while violin is the smallest in the family. Double bass produce the low notes due to 

its largest body compared to others. The violin produces the highest pitch. 



5 
 

The major parts of this instrument can be referred in APPENDIX A which are Scroll, 

Peg Box, Nut, Fingerboard, String Roller Hole, Top part, Strings, the Bridge, F-

Holes, Sound post and Tailpiece. Each part play important role toward the body 

vibrational frequencies. Another important part which is not included in these 

instruments body is the bow. The rate of quality of the bow can be measured 

according to its playing properties and its tonal qualities (Neville, 2000).  

Other than that, the timbre or tone colors of stringed instruments are much dependent 

on various factors such as instrument stimulus spectrum, waveforms, sound 

pressure/loudness, pitch of tone, temporal characteristics and sustain duration 

(Pickering, 1997). 

The motion of the top plate of the body which is the source of most of the bass sound 

is the results of a complex interaction between the driving force from the string 

through the bridge and the various resonances of the instrument’s body. More 

specifically, the vibrational characteristics of bass wooden plate is determined by 

various factors such as size, shape and design, thickness, arching, density, 

mechanical properties (Haines, 2000) such as stiffness and internal damping which 

more or less relate its structure (Segerman, 2001) and inorganic content (Bucur, 

2000), moisture content (Hutchins, 2000) (Thompson, 2000), relative humidity 

(Thompson, 2000), type of varnish and temperature. These are factors which might 

have been motivated ones to develop synthetic composite materials instead of wood 

musical instruments (Besnainou, 2000). 

Vibrational resonances modes (Woodhouse, 2002) of stringed instrument body have 

become visually significant. It has been proven that tonal quality as well as timbre of 

an acoustic instrument such as the double bass will be very much dependent upon 

pitch (Rodgers, 2001), phase of each high frequency harmonic components (Plomp, 

1969) and their variation in transient pattern with time (Fletcher, 1996). 
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Apart from the sole presence of body enclosed air (Bissinger, 2001) there is also 

influence of air-body coupling (Hutchins, 2000) which in effect subsequently alter 

the directivity patterns (Wang, 1999) of sound radiation (Weinreich, 2002) 

emanating from the instrument. Finally, the effect of long term cyclic deformation 

due to long term playing (Hutchins, 2000) or the age of the instrument is worth 

mentioning. 

Focally for bowed stringed instrument; Double Bass, the acoustic characteristics is 

particularly affected by the bridge and mid portion of the top plate between f-holes 

(Jansson, 1997). Currently in this project, the author is going to focus toward the 

bridge, by assuming that it has the role as the major characteristic determining part of 

the whole vibrating system of the instrument. The details on the relation of the bridge 

in the production of acoustical characteristic will be explained later in the next sub-

section. 

2.2 Acoustical Characteristics and the Bridge 

The definition of acoustic is the study of sound which generally refers to 

transmission of sound through solid and fluid media and any other phenomenon 

engendered by its propagation through media (Daniel, 2000). Daniel (2000) says that 

an acoustic signal can arise from a number of sources such as turbulence of air or any 

other gas, the passage of a body through a fluid, or the impact of a solid against 

another solid. The most common unit of frequency used in acoustic is Hertz. 

Significantly, acoustic is a matter of communication as the message is tried to be 

conveyed effectively by minimizing effect of noise (Daniel, 2000).  

 

Figure 2: The Bridge of Contra Bass 
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Apart from that, the bridge (as per Figure 2)  is then functioning as transforming the 

motion of vibrating strings into periodic driving forces applied by its two feet to the 

top plate of the instrument. Many studies had been done on the effect of the bridge to 

the sound and frequency production. Savart (1937) says that shaping the bridge is a 

convenient and effective way to alter the acoustic characteristic of the instrument 

(Savart, 1937). Bridge has a large number of vibration modes such as longitudinal, 

flexural and torsional vibrations which can be determined using Holographic 

interferometry (Neville, 2000).  

In another study, Bladier (1960) concluded that the bridge acts as an acoustical lever 

or amplifier with a gain of about 2 (6 dB) between 66 and 660 Hz, decreasing to 1 or 

below above 600 Hz (Bladier, 1960). The bridge is generally carved quite 

symmetrically due to aesthetic reasons (Neville, 2000). Referring to other findings, 

the misaligned of the bridge also may affect the sound produced (Joseph, 2012). 

Cutting of some part of the bridge may also contribute to tonal consequences. In 

conclusion, the bridge can be considered as an essential part in the role of producing 

the timbre wood-bass characteristics.  

2.3 Sound Transducers 

Sound transducer, similarly functions as sensor, amplifier or transducer is device 

used to capture mechanical vibrations and convert them into electrical signal that 

then can be amplified and recorded as required. There are basically two types of 

pickup which passive; which not requires any external source of power while active; 

as they need preamplifier and external source before directly transmitted to Main 

Power Amplifier.  

Over centuries, amplifications technology has developed vastly. There are many 

types of transducers have been introduced to the world of music. Some of them can 

be referred in Table 1. 
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Table 1: Variation of Sound Transducers (Jonas, 2012) 

TYPE OF TRANSDUCER DESCRIPTION 

 

Microphone 

Usually, this type of pickups will be 

mounted between bridge and fingerboard 

which will ensure the audio reinforcement 

is achieved when performing live. 

Disadvantage: Problem dealing with 

external noise. 

 
Magnetic 

This type of pickup consists of permanent 

magnet. It is often mounted on the body of 

the instrument but also can be attached to 

the bridge. 

Disadvantage: Magnetic sensor causes the 

effect of magnetizing the sound and 

produce higher output sound. 

 

Pickup 

Mounting Clamp 

This pickup is mounted to the body. Made 

up of rubber-like-plastic to prevent the 

clamp from buzzing. 

Disadvantage: Not feasible and does not 

consider aesthetic value. 

 

Piezoelectric Ceramics 

Has been used widely for string family 

instruments due to its ability of not picking 

up any other magnetic fields. 
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2.4 Method to Determine Stress Concentration Area 

The author has done thorough analysis for each related component whereby deep 

reading has been done in order to get the understanding on the project. Assisted by 

Supervisor, AP Dr Bambang Ariwah Joedi, the author has identified some available 

methods that can be used to obtain stress concentration on bridge surface. The 

method can be viewed as per Figure 3. 

 

Figure 3: Possible Approaches in Determining Stress Concentration 

Basically, there are two types of method that can be used in determining stress 

concentration which are analytical or experimental method. As if the experimental 

method is chosen, there are two ways in determining the stress concentration which 

are either use Photo-elastic Technique or Bridge Replication (Labossiere, 2007).  

Photo-elastic Technique is one of the most powerful techniques which are able to 

identify stress concentration easily. It manages to gives overall picture of stress field 

showing region of stress intensification. Furthermore, the direction of principal 

stresses is also easily determined. This method requires a model of the shape 

analysed (the bridge) which is made from a suitable transparent material. The 

changes in properties when loaded in similar manner to the real part will be 

measured by polariscope. The phenomenon of synthetic birefraction is the basis of 

photo-elastic techniques (Labossiere, 2007). 
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Other option is using Elastomers Model. This method is usually chosen when the 

elastic behaviour is the main concern. Metal specimens are bad in demonstrating 

elastic behaviour and stress concentration effects due to their high stiffness. On the 

surface of the specimen, a square grid of lines is printed. While the specimen is in the 

loading frame, the shape of the square grid will be carefully observed (Labossiere, 

2007). 

The third option when choosing experimental method is using Brittle Coating. 

Labossiere (2007) said that this is the most straight-forward methods of experimental 

stress analysis. Much more sensitive brittle coating known as Spray Stresscoat is 

available nowadays with the ability to crack at strain levels as low as 400        

The Stresscoat is simply sprayed on to an average film thickness and dried for 

several hours. There is guideline provided to read the series of crack when the 

specimen is hold in special loading fixture (Labossiere, 2007).  

Considering Analytical Method, the author would have two options which are using 

Finite Element Analysis or Mathematical Modelling. It is a tedious work to come up 

with formula and solve it manually. Even though software as Mat Lab is used, still it 

requires more effort in finding the stress concentration. In contrast, Finite Element 

Analysis provides much easier ways compared to the Mathematical Modelling. Finite 

Element Analysis (FEA) can be done using ANSYS software which will further 

explain in next subunit. All in all, FEA has been chosen as a way to determine the 

stress concentration point as it provides the easiest approach among others. 

Experimental Method may be implemented as recommended future work. 

 2.4.1 Finite Element Analysis 

Finite Element Analysis (FEA) is dividing the complex objects into much simpler 

and manageable elements (Liu, 2003). It can be applied in computer simulation such 

as ANSYS. 3D Elasticity Theory in Mathematical Modelling method is able to 

analyse stress concentration area of a 3D object as shown in Figure 4. 
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Figure 4: Stress State for 3D Problem (Liu, 2003) 
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Stress-Strain Relation: 
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Solving equation 1 with strain displacement relation and element equilibrium 

equations under boundary conditions will lead to stress, strain and displacement 

analysis but note that analytical solutions are difficult to solve. In contrast, using 

Finite Element Formulation, stress will be evaluated based on selected points 

including nodes on each element (Liu, 2003). Available FEA software are ANSYS, 

ABAQUS, HyperMesh, COSMOS and many more. Among them all, ANSYS is one 

of the software which is available in Universiti Teknologi PETRONAS and it is 

feasible to use it. Figure 5 shows the steps in the ANSYS FEA Procedure. 

 

Figure 5: FEA Computer Implementation 

At the end of Final Year Project, it is expected that the author will be able to generate 

stress concentration field on the surface of the bridge. 
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According to Figure 5, there are three (3) main stages: 

1. Pre-processing 

i. Solid Modelling  

Referring to ANSYS terminology, solid modelling or often called 

model generation means the process of defining the geometric 

configuration of the model’s nodes and elements. In ANSYS, it 

provides some approaches in order to produce 3D modelling which 

are: 

 Creating a solid model within ANSYS. 

 Using direct generation. 

 Importing a model created in a computer-aided-design (CAD) 

system. 

The author has chosen step 3 to draw 3D modelling of the bridge. 

Detailed procedures in generating the model will be discussed in 

Chapter 3: Methodology. 

 

ii. Element Type 

The author has to specify the element type that is going to be 

analysed. In the Element Library, it includes a summary table of 

element input. Element type is identified by a name which consists of 

a group label and unique identifying number. In this project, the most 

suitable element is SOLID285. Usually, SOLID285 is applicable for 

3D modelling of general solid structures. It is defined by eight nodes 

having three degrees of freedom at each node: translations in the 

nodal x, y and z directions. The element has the function of plasticity, 

hyper elasticity, stress stiffening, creep, large deflection and large 

strain capabilities. The effects of pressure load stiffness are 

automatically included in this element.  
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iii. Material Properties   

In the function of defining Material Properties, the author needs to 

define material properties, material models and model combinations. 

The bridge is made of Maple, sugar (Acer saccharum) which is 

having Young Modulus of               . 

 

iv. Mesh Line  

Meshing is the next step after defining element attributes. ANSYS 

offers a large number of mesh controls though as for the project the 

author chose free mesh for the complex shape of the bridge. Free 

mesh has no restriction in terms of element shapes and has no 

specified pattern applied. 

 

2. Solution 

i. Load  

Load can be applied on the solid model whether on key points, lines 

or areas. The solver will treat all loads to be in terms of the finite 

element model. Any specified loads on the model will automatically 

transferred to nodes and elements at the beginning of solution. In the 

project, there will be three (3) different cases which are: 

CASE 1 

Static bridge: the force is coming from the tension of the string. 

CASE 2 

CASE 2(a): Only string G is bowed to the right. 

CASE 2(b): Only string D is bowed to the right. 

CASE 2(c): Only string A is bowed to the right. 

CASE 2(d): Only string E is bowed to the right 

CASE 3 

CASE 3(a): Only string G is bowed to the left. 

CASE 3(b): Only string D is bowed to the left. 

CASE 3(c): Only string A is bowed to the left. 

CASE 3(d): Only string E is bowed to the left. 
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String tensions are applicable in each case. The only difference is the 

addition of the force acting due to bowing action to the left and to the 

right. Additional forces from bowing action to the left and right are 

vary at about 1.5 N (Neville, 2000).  

 

Figure 6: String Tension Holds the Bridge from Slip 

 

Figure 7: Free Body Diagram of Unbowed Bridge 

Figure 6 shows the position of the bridge on the bass body and Figure 

7 shows free body diagram when the bridge in static position (only 

string tensions are acting on the bridge). Downward force string 

tension will be determined from the average value of string tension as 

per Table 2. 

Table 2: String Tensions (BAEN, 2007) 

String Type G D A E 

Pirastro Eudoxa 295.04 291.03 284.36 289.25 

Pirastro Flexocore 299.04 295.04 321.74 291.92 

Pirastro Obligato Orchestra 291.92 288.36 290.14 285.25 

Pirastro Oliv 281.24 270.56 262.55 266.56 

Pirastro Permanent 295.93 290.14 286.14 280.35 

Thomstik-Infield Precision 

Orchestra 127 
313.73 313.73 343.10 343.10 

Thomstik-Infield Spirocore Soft 

(Weich) S42 
264.78 284.36 294.15 303.94 

Thomstik-Infield Spirocore Medium 

(Mittel) S42 
294.15 313.73 333.75 333.75 

Average 291.98 293.37 301.99 299.26 
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Figure 8: String Tensions Chart 

The author will apply the average string tension on the bridge model 

in ANSYS. 

 

ii. Constraint  

At the bottom of the bridge, there will be a fix displacement force 

acting which avoid the bridge from slipping. 

 

3. Post-processing  

Based on the project, one of the objectives is to determine the best mounting 

position of the sound transducer which believes on the highest stress 

concentration area. Due to that, the author interest is to obtain stress analysis 

through stress contour diagram. Detailed methodology and results of the 

analysis will be further explained in the next chapter. 
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CHAPTER 3 

METHODOLOGY 

 

3.1 Research Methodology 
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Figure 9: Project Process Flow 
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Figure 9 shows the planned flow chart of the project. Based on the flowchart, the 

steps and direction of the project can be seen clearly. It has been designed to fully 

utilise the time frame given to complete the project. The project will be divided into 

five main stages which are first, doing the preliminary research work. Second is to 

prepare the literature review to build better understanding of the project. The third 

stage is the development of 3D drawing of the bridge. Next is to determine stress 

concentration by simulating the 3D drawing using Finite Element Method. The last 

stage will be the final documentation that compiles all the research works and 

presents the outcome of the project. 

3.2 Project Activities 

Each stage is then discussed in detail as per Table 3. The project activities give the 

basic overview of what is going to be done throughout the completion of the project. 

Table 3: Project Work Description 

METHODOLOGY DESCRIPTION 

Research Work 

Perform comprehensive study on the 

characteristic of double bass also other essential 

parts involved in the project such as the bridge.  

Literature Review 

Set out clear objectives and prepare the outline 

(scope of the project) using outcome of the 

research as a guideline. Understand deeply each 

essential part. 

3D modelling in CATIA: 

Sketch Tracer 

3D drawing of the bridge is drawn using CATIA 

Sketch Tracer. 

Stress Concentration 

Determination 

Simulate the drawing by assigning profile to the 

bridge (i.e., acting force). Determine stress 

concentration on the bridge using Finite Element 

Analysis in ANSYS.  

Final Documentation 
Outcomes of the project from the beginning of the 

project will be documented for future use.   



19 
 

Research work can be considered as an essential part of the project as it’s the starting 

point to get to know into deep with the project. Through research work, some 

previous work and references have been referred to. However, there are no specific 

previous researches that were focussing on the effect of locating the sensor on the 

different area on the bridge. Based on research work and literature review, the author 

has come up with the idea on the development of 3D drawing of the bridge and on 

how to determine stress concentration location. 

 3.2.1 Development of 3D Drawing of the Bridge 

At the beginning of the project, the author decided to apply Reverse Engineering 

knowledge in order to develop 3D drawing of the bridge. Computer Aided Reverse 

Engineering Technology Machine or also known as Digitizer is available in Building 

16, Universiti Teknologi PETRONAS which it able to scan a 3D object and convert 

it into 3D drawing. Unluckily the machine is currently under maintenance and takes 

at about three months to repair. Due to that, the author has chosen to use CATIA: 

Sketch Tracer function. In order to use Sketch Tracer Function, the author needs to 

sketch the bridge manually using pencil on the paper as per Figure 10. The sketch 

was then being scanned using normal scanner. After transferred as image, the 

drawing is ready to being traced in CATIA. Details procedures can be referred in 

APPENDIX C. 

 

Figure 10: Sketch of the Bridge 
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After undergone drawing steps in CATIA, the 3D solid modelling is successfully 

built. Figure 10, 11, 12 and 13 each show the view from each side of the bridge 

which have been captured from CATIA. 

 

Figure 11: Isometric View of the Bridge 

 

Figure 12: Top View of the Bridge 

 

Figure 13: Front View of the Bridge 

 

Figure 14: Side View of the Bridge 
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3.2.2 Stress Concentration Determination in ANSYS 

Previously, it has been stated that the author will chose Finite Element Analysis in 

order to determine the highest stress concentration area on the bridge which believes 

will be the best mounting position of sound transducer. Finite Element Analysis will 

be applied using ANSYS software. As can be seen in Figure 15, the 3D solid 

modelling produced by CATIA can be imported successfully into ANSYS for 

analysis. Detail procedures can be referred in APPENDIX D. The results of each 

case will be discussed in Chapter 4: Results and Discussions. 

 

 

Figure 15: 3D Solid Modeling of the Bridge in ANSYS 
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3.3 Gantt Chart with Key Milestone 

The Gantt chart is built as a guideline for the project timeline. It can be changed from time to time depending on certain circumstances. The key 

milestone will be functioned as monitoring the work progress and to accurately determine whether or not the project is on schedule. 

Table 4: Project Scheduling of FYP 1 

No Descriptions/Week 1 2 3 4 5 6 7 8 9 10 11 12 13 14 

1 Topic Selection and Confirmation               

2 Preliminary Research Work               

3 Preparation of Extended Proposal               

4 Transformation of Bridge into 3D Drawing               

5 Proposal Defence               

6 Study and Familiarize with Simulation Software               

7 Run Stress Point Simulation               

8 Preparation of Interim Draft Report               

9 Improvement of Interim Draft Report               

 

 
Process Suggested Milestone 

 



23 
 

 

Table 5: Project Scheduling of FYP 2 

No Descriptions/Week 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 

1 Stress Point Determination using ANSYS                

2 Submission of Progress Report                

3 Stress Point Confirmation                

4 Pre-SEDEX                

5 Submission of Draft Report                

6 Submission of Dissertation (soft bound)                

7 Submission of Technical Paper                

8 Oral Presentation                

9 Submission of Project Dissertation (hard bound)                

 

Process Suggested Milestone 
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3.4 Tools/Software Selection 

Throughout the project, the main software used are CATIA P3 V5R17 and ANSYS 

14.0. CATIA is used in order to translate the bridge into digitize solid modelling 

while ANSYS is used to determine the stress concentration area which is proposed to 

be the best mounting position of the sound transducer. Other than that, the author 

also used Microsoft Office 2010, for the final report preparation and compilation. All 

software needed are available in Universiti Teknologi PETRONAS laboratory. 
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CHAPTER 4 

RESULTS AND DISCUSSIONS 

 

This chapter compiles the results and discussions of the projects. It contains the 

results retrieved from Finite Element Analysis (FEA) done in ANSYS. 3D solid 

modelling of the bridge was successfully developed in CATIA and being imported to 

be analysed in ANSYS. The detail on force acting in each case was previously 

explained in Chapter 2. 

4.1 CASE 1: When The Strings Are Not Bowed 

The model was first being analysed during its static condition when the strings were 

not bowed. Only string tensions were acting along the top of the bridge. As per 

Figure 16, it can be seen that, the highest stress concentration area was observed at 

curvy part of the bridge under string G. This shows that although during unbowed 

condition, the string tensions itself have given some stress to the bridge. 

 

Figure 16: Stress Contour Diagram of CASE 1 
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4.2 CASE 2(a): Only String G Is Bowed To The Right 

The analysis was then proceeded to the bowed condition. All together, there are four 

(4) strings and there will be four possible conditions when the string is bowed to the 

right. The first case is when only string G is bowed to the right as per Figure 17. 

 

Figure 17: Forces Acting on Top of the Bridge in CASE 2 (a) 

As the result, the highest stress concentration area is observed located in the same 

position as previous case. 

 

Figure 18: Stress Contour Diagram of CASE 2 (a) 
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4.3 CASE 2(b): Only String D Is Bowed To The Right 

Next is when only string D is bowed to the right as shown in Figure 19. As a result as 

per Figure 20, the stress concentration area seems to be at the same position which is 

near the curvy area under G string location. 

 

Figure 19: Forces Acting on Top of the Bridge in CASE 2 (b) 

 

 

Figure 20: Stress Contour Diagram of CASE 2 (b) 
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4.4 CASE 2(c): Only String A Is Bowed To The Right 

When only string A is bowed to the right as per Figure 21, the result was observed to 

show the same position of highest concentration area. 

 

Figure 21: Forces Acting on Top of the Bridge in CASE 2 (c) 

Both areas at the waist having highest stress acting on them. Between the two, the 

highest is the one near the G string location. 

 

Figure 22: Stress Contour Diagram of CASE 2 (c) 
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4.5 CASE 2(d): Only String E Is Bowed To The Right 

Figure 23 shows the forces acting on the top of the bridge when only string E is 

bowed to the right. 

 

Figure 23: Forces Acting on Top of the Bridge in CASE 2 (d) 

The result shows that the highest stress concentration area is located at the waist near 

the G string (curvy area). 

 

Figure 24: Stress Contour Diagram of CASE 2 (d) 
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4.6 CASE 3(a): Only String G Is Bowed To The Left 

The analysis was then proceeding to the next case which is when the string is bowed 

to the left. There will be four (4) possible cases. Firstly, as per Figure 25, case when 

only string G is bowed to the left. 

 

Figure 25: Forces Acting on Top of the Bridge in CASE 3 (a) 

Results in ANSYS shows that the highest stress concentration area was observed to 

be at the both waist of the bridge. The highest is at curvy location near G string. 

 

Figure 26: Stress Contour Diagram of CASE 3 (a) 
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4.7 CASE 3(b): Only String D Is Bowed To The Left 

Next is the case when only string D is bowed to the left. The result is shown as per 

Figure 28. The highest stress concentration area was observed to be similar as 

previous cases. 

 

Figure 27: Forces Acting on Top of the Bridge in CASE 3 (b) 

 

 

Figure 28: Stress Contour Diagram of CASE 3 (b) 
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4.8 CASE 3(c): Only String A Is Bowed To The Left 

Figure 29 shows the forces acting on top of the bridge when only string A is bowed 

to the left. The force acting is having the same magnitude as CASE 2 but different in 

direction. 

 

Figure 29: Forces Acting on Top of the Bridge in CASE 3 (c) 

The result is shown in Figure 30. The highest stress concentration area is located at 

the waist near G string location. 

 

Figure 30: Stress Contour Diagram of CASE 3 (c) 



33 
 

4.9 CASE 3(d): Only String E Is Bowed To The Left 

Finally, the last possible case is when only string G is bowed to the left. The forces 

acting during this case is shown in Figure 31. 

 

Figure 31: Forces Acting on Top of the Bridge in CASE 3 (d) 

As the result, the location of the highest stress concentration is determined to be at 

the curvy area near G string location. 

 

Figure 32: Stress Contour Diagram of CASE 3 (d) 
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4.10 Discussions 

At the end of the analysis, the author observed that all the cases had shown the same 

location which having the highest stress concentration. The location with the highest 

stress concentration is determined to be at the middle of the waist near the curvy side 

of the bridge under G string location. The results obtained are similar in any case 

may be due to the shape complexity which cause the curvy area to be the critical area 

and cause the stress to be concentrated at the area.  

 

Apart from that, the analysis had shown that this new position could be proposed as 

the best mounting position of sound transducer in order to reproduce wooden timbre 

characteristics of contra bass.  
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CHAPTER 5 

CONCLUSION AND RECOMMENDATIONS 

 

5.1 Conclusions 

In conclusions, the author was successfully completed the project. The objectives set 

at the beginning of the project were all achieved. The bridge was translated into 

digitized 3D solid modelling using CATIA: Sketch Tracer instead of applying 

Reverse Engineering technology. The model was then being analysed using Finite 

Element Analysis (FEA) and the best mounting position was successfully determined 

as the author proposed the area with the highest stress concentration is the most 

suitable mounting position. The position was then observed to be at the curvy part of 

the bridge. At all cases, they gave the similar location of concentration area as the 

position at the curvy part at the middle of the waist is giving the highest stress 

concentration in any case and could be proposed as the mounting position of sound 

transducer. 

5.2 Recommendations 

For continuation of the project, the author proposes to implement the sound 

transducer at the position determined from the Finite Element Analysis. The 

implementation of the sound transducer can be followed by having experiment in 

order to compare the sound quality produced by the bridge with sound transducer 

located at the current position in the market and the sound quality produced by the 

bridge with the sound transducer mounted at the new proposed position determined 

from the project. The result from the experiment will assist the analytical analysis 

made. 
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APPENDIX A 

Parts of Double Bass/Cello

 

Figure 33: Parts of Double Bass/Cello
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APPENDIX B 

Multi View of 3D Drawing of the Bridge 

 

Figure 34: Multi View of 3D Drawing of the Bridge 
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APPENDIX C 

Procedures of converting the bridge into 3D solid modelling using CATIA P3 

V5R17: 

1. CATIA V5 was loaded. Sketch Tracer function was selected from the Start 

Menu. 

Start > Shape > Sketch Tracer 

 

Figure 35: Start Bar Menu 

2. The view was changed to front view by clicking  icon. 

3.  Shading with material function was chosen by clicking on   icon. 

4. Immersive sketch was created by clicking on  icon. 

5. File containing the bridge sketch image was loaded. 

 

Figure 36: Scanned Sketch of the Bridge 
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6. Cube view in Sketch Parameters toolbar was chosen. 

Sketch Parameters > Use a cube >  Reload Image > OK 

 

Figure 37: Sketch Parameters 

7. In the same file, new part design was opened. 

Product (right click) > Components > New Part 

 

Figure 38: New Part Command 
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8. Double click on the part body to start new part drawing. At this point 

forward, the drawing was made referring to the image uploaded. 

Product > Part1 > yz plane > Click   

Use any icon to obtain the best fitted line of the image. Icon available such as ,

,  and many more. 

 

Figure 39: The Sketch acts as Reference 

9. After completed the drawing, proceed for 3D modelling. 

 

Figure 40: 2D Drawing of the Bridge 
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10. The sketch was extruded using  icon. Next, lines were drawn on the side 

view of the bridge. The top width will be 1.00 cm while the bottom is 2.40 cm in 

width. The shape was extruded with thickness similar to the width of the bridge. 

Boolean operation was applied. 

 

Figure 41: ANSYS Interface 

11. 3D modelling of the bridge will be completed once the shape was extruded. 

  

Figure 42: 3D Solid Modeling of the Bridge 
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APPENDIX D 

Procedures followed throughout the analysis in ANSYS: 

1. 3D solid model of the bridge in CATIA V5 was imported into ANSYS. 

File > Import > CATIA V5 

 

Figure 43: Start Menu Bar 

Browse > Open “file name” > Allow model defeaturing > Geometry Type: All 

 

Figure 44: ANSYS CATIA V5 Import 
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2. Element type and material properties of the model were defined. 

Pre-processor > Element Type > Add / Edit / Delete > NONE DEFINED > 

SOLID285 > OK 

 

Figure 45: Library of Element Types 

Pre-processor > Material Props > Material Models > Material Model Number 1 

> Structural > Linear > Elastic > Isotropic > EX = 1.26E10 > OK 

 

Figure 46: Define Material Model Behavior 

 

Figure 47: Linear Isotropic Properties for Material Number 1 
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3. Next, the model was meshed using the mesh tool. 

Pre-processor > Meshing > Mesh Tool > Mesh > Select Object > OK 

 

Figure 48: Mesh Tool 

 

Figure 49: Select Object to be Meshed 
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4. Analysis type was set to static analysis. 

Solution > Analysis Type > New Analysis > Static > OK 

 

Figure 50: New Analysis 

5. Fixed support at the bottom of the bridge was defined. 

Solution > Define Loads > Apply > Structural > Displacements > On Areas > 

Select Areas > OK 

 

Figure 51: Fixed Support on the Bridge 
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6. Forces acting at the top of the bridge were defined. 

Solution > Define Loads > Apply > Structural > Force/Moment > On Nodes > 

Select Nodes > OK 

 

Figure 52: String Tension acting on Top of the Bridge 

Direction of Force / Moment > FZ > Fill up Force / Moment value (refer to 

Table for the force value) > OK 

Table 6: String Tension 

STRING G D A E 

Force (N) 291.98 293.37 301.99 299.26 

 

 

Figure 53: Apply Force/Moment on Nodes 
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7. Proceed to solve the analysis. 

Solution > Solve > Current LS > OK 

 

Figure 54: Solve Current Load Step 

 

General Postproc > Read Results > Last Set 

General Postproc > Plot Results > Nodal Solution > von Mises stress > OK 

 

Figure 55: Contour Nodal Solution Data 

 

Once OK button was clicked, the stress contour diagram will be displayed. 


